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Cubase is music production software - often called a Digital Audio Workstation 
(DAW) - and one of its features is that it is a sequencer.  This means it can record 
notes that you play on a keyboard, and then play them back through a synthe-
sizer, allowing you to create compositions and hear what they sound like without 
using other musicians.  Very complex pieces of music can be built up doing this as 
you can create one track at a time and re-record it until you are totally happy with 
it, all at your own pace.  You don’t need to be a good keyboard player to get good 
results, either (although having some keyboard skills is a big help).  It’s important 
to remember that it deals with MIDI (which will be covered fully later on), and 
that really means notes being played, usually on a keyboard, so you can change 
the sound of what you’ve recorded afterwards, but there are some limitations to 
how it will sound.

Getting Started
Firstly you will need to start your computer and any other items in your setup.  
The order of this will change depending on your specific equipment, but there is 
a good rule of thumb here:
Tip: The speakers should be the last thing you turn on, and the first thing that you 
turn off – this is to avoid any ‘thumps’ damaging them (or your ears) when you 
turn the equipment on.  Usually the computer will be one of the first things to be 
turned on and the last to turn off. Once this is done, you can start Cubase. 

 Once it loads (which can take some time as it’s a large 
program), you will see a screen like the one on the left, 
it is the Steinberg Hub and it is there to allow you to 
pick from a number of templates, as well as tell Cubase 
where you want your project to be saved.

Tip: Whenever you use Cubase, it’s important to make sure your files are where 
they should be – in some situations the computer is used by a number of people, 
and in addition it’s really important to save each project in a separate folder – this 
means you will easily be able to back your work up later on.
To create a new folder for your project, click in the area next to Project Folder at 
the bottom right of the Steinberg Hub window, and type the name of the folder 
you want to create, and then in the upper section click More and then pick Empty.  
Now click the Create button at the bottom and Cubase will make the folder and 
a new project. 
Tip: Remember that USB flash drives and external hard drives are becoming in-
creasingly affordable, and their cost is small compared to the amount of time 
that you would need to recreate any work if it was lost.  Backing up your work is 
a necessity, as is regularly saving your work.  Computers crash, particularly when 
running complex software such as sequencers, and hard drives fail.  If you save 
regularly and back up often then you will not lose a great deal if the worst hap-
pens.
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Here we see the main Cubase window, 
with the Transport Bar at the bottom.  The 
transport bar is like the remote control 
for a video recorder, although it has more 
functions, the basic controls are the same, 
as we’ll see later on. The central area is 
the project window.  This is where all your 
tracks will be created and the majority of 
your work will be.

The first thing to do is to create a new track.  Go to Project > Add Track > In-
strument, and a new window will appear where you can select an Instrument.

Click where the window says No VST Instrument and a list will appear of the in-
struments your computer has available.  Pick Halion Sonic from the Synth folder 
(as it is available on all Cubase systems), and click Add Track.  You should now see 
a screen similar to the one shown below.

Here is the Cubase window, with Halion 
Sonic located in the centre of the screen.  
While you will be editing the controls later 
on, at the moment we don’t need to see 
Halion Sonic, so close the window to re-
veal...

... the project window with Halion Sonic 
track in it. On the left of the screen is the 
Inspector, showing details such as track 
name, inputs and settings.  If the inspector 
isn’t present...

... click this button to make it visible.  It can 
also be enabled with CTRL + ALT + L.

The Inspector is very important as it allows you to alter the volume and panning 
of a track (more of this later), and most importantly pick the sounds you wish to 
use.  We will see how this works in a while, but firstly we will look at a few things 
we need before we get started.
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The Transport
The transport (hit F2 if you can’t see it) allows us to control Cubase, making it play, 
stop, record, rewind and a host of other features.  We won’t cover them all here, 
but we will cover the basic controls that you need to get you sequencing.

The transport controls. The highlighted button is STOP, 
and to the right are PLAY and RECORD.  The button on 
the left turns CYCLE on and off, allowing us to repeat a 
particular section - see page 11.
Tempo Control and Tap Tempo.  Here the tempo can 
be set (once the tempo track is turned off by clicking 
the button at the left). The song tempo can be entered 
by numerical entry or by clicking the tap button.
Metronome and count-in.  Here the click can be turned 
on and off with the left-hand button, and count-in (for 
recording) can be controlled with the middle button.  
The e allows more control of metronome options.

Time readout.  This can be in a number of formats, but 
bars and beats (at left) is probably the best setting.

Locators.  As we’ll see later on, the locators allow us to 
cycle round a section, to practice it or record several 
times.  They can be set by double-clicking the numbers 
and typing a new value.
Input/Output activity.  This shows MIDI in and out (left 
two meters) and audio input and outputs (stereo).

The Transport Bar in Cubase is highly configurable - and would take several pages 
to describe all the available options - but suffice to say that you can turn sections 
on and off right-clicking on an empty section of the transport bar, and selecting 
the sections that you want to see from the set up window that appears. You can 
alter the appearance of each section by clicking the three dot menu to the right 
of each section.

Here we see the effect of this on the transport 
controls section.  The first view is the default 
with just four controls present.  The next mode 
adds buttons to move between markers, and the 
third mode adds fast forward and rewind con-
trols.
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The Metronome
It is very important that when you play music into Cubase that it is in time with 
the metronome.  Computers may work extremely quickly, but they do not have 
much intelligence, and as a result they need to be told things that we may take 
for granted.  One of them is the tempo of a piece of music – Cubase can’t really 
work that out, so to make life easy in the long run, you should play in time with 
the metronome.  This is easily achieved, firstly by turning it on using the button 
above - it will turn white. Pressing Play on the transport bar should now mean 
you hear an indication of the tempo of the piece. 

Changing Tempo
If you want to change the speed, make sure that the tempo track is turned off 
click the button above on the transport bar so that it is dark grey, and then enter 
the tempo that you want by double-clicking it and typing the speed you want, 
or tapping the tempo on the Tap area to the right of the tempo indication.  You 
may need to experiment to find the right speed, and remember that you can al-
ways change the speed of what you’ve recorded after you’ve done it.  This has an 
important benefit if you’re finding a part difficult - you can record difficult parts 
slowly to make them easier to play, then return the tempo to normal afterwards.
Picking a sound
Many synthesizers provide a wide range of sounds (referred to as patches) and 
these should cover most eventualities – there are usually over a hundred on a 
basic synth, and on some there can be thousands.  However, picking them can be 
a little difficult as there are so many to choose from, but the Inspector makes it 
easier.

Here is the routing section of the Inspector of the 
Halion Sonic track.  You may need to click on Rout-
ing to expand it to see this section in full. When a 
sound is selected it will appear where it currently 
says Program Selector, so click there... 



6

Sequencing - Sample Chapter

Sa
mple

 do
wnlo

ad
ed

 fr
om

www.m
us

ict
ec

ht
uiti

on
.co

m

... and the patch list appears.  Here you can list all 
the sounds that the synth has, and there are many 
(6120, as shown at the top right).  If you want to 
explore, feel free to do so, you can scroll through 
the list and click once on a sound and you will be 
able to hear it played using your MIDI keyboard 
– you may find a sound that inspires you or takes 
your compositions in new directions. 

There are so many sounds that it’s hard to find the 
right one quickly.  If you click where it says Search 
MediaBay and enter a word (or part of one) then it 
will only show you sounds that are relevant to that 
– both in their names and also their categories/de-
scription, so if you enter piano (as seen here) then 
you should get piano sounds, even if their name 
doesn’t make that obvious.  Not all instruments 
have descriptions in their patches, however.

Naming Tracks
It’s important to name each track – at first it’s easy to know what’s what as you 
may only have one or two tracks.  When your piece develops, you may end up 
with many tracks, and knowing instantly what each one is will help.  To name it, 
double click where the track says Halion Sonic 01 and name it appropriately – 
melody, bass, chords or whatever you want to call it. 

The Info Line
If you have the Info Line present (if it isn’t, click the icon above right and select 
it from the menu that appears), then you can name the parts you create as well, 
avoiding confusion if you have musically different parts.  It can also be of benefit 
to use the colour palette  to colour parts, providing an instant visual clue when a 
part is different from its neighbours.

Toolbar and Transport Setup
There is a great deal of information that can be present on screen in Cubase, and 
both the toolbar and transport bar area have too many options to fit on most 
screens.  As a result, you will need to be familiar with getting the tools you need 
on screen.  This is done right-clicking in empty space on the area in question, 
and using the pop-up window to select the appropriate sections. If a tool, icon or 
menu is mentioned in this book and you can’t see it, then right-click the area and 
turn that section on.  You may need to turn other sections off to see the desired 
section in full - particularly in the case of the transport bar (where some sections 
can be expanded in size, as seen on page 4).
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Making a recording
Cubase will record whatever you play on the keyboard.  To do this, select a track 
(if you only have one it will already be selected, this is shown by it being lighter 
than the others), and look to see that the red ‘record enable’ button is lit up on 
the track itself – it should be as soon as you select the track, but it’s possible for 
it to be turned off.  This button doesn’t mean that the track is recording straight 
away, but it means that when you press record it will record on this track.  Next, 
we need to tell Cubase to give us a count-in (normally this is 2 bars).  This is done 
by activating the Count-in button, near the metronome button– it looks like this: 

If you can’t see the count-in button, press the three dots to the right until you can 
see it. Now make sure Cubase is at the start of the song, and hit Record.  Cubase 
will give you a 2 bar count-in, and then start recording.  Play something on the 
keyboard, and you should see it appear as you’re recording.  Once you’re happy, 
press Stop.  Go back to the beginning of the piece (pressing , on the keyboard next 
to M will do this, although a good way to remember it is to think of the < pointing 
back to the start of the project) and press play to hear what you recorded.
If you’re not happy with the recording, then often the best thing to do is to delete 
it and start again – unless there is some unique part of it that you think you could 
never reproduce, the best thing to do is to start again, as this will improve your 
keyboard skills quite quickly if they need to be improved, and mean that in the 
future you can sequence things with much more speed and accuracy.  
Tip: To delete a part, select it (left-click it) and then hit Backspace on the com-
puter keyboard.  
To record again, just repeat the steps above.
Snap
Snap is extremely important.  Without it, it would be very difficult to make parts 
in the project window which were exactly the right length, whether it’s bars or 
beats we are after. What snap does is makes sure that any movements you make 
and any edits you do are constrained to a grid, which minimizes the room for 
errors. Whenever you’re making any changes in the project window, make sure 
that snap is turned on, and initially make sure that it’s set to Bar.  The settings for 
Snap are found at the top of the project window, and the correct ones are shown 
below:

The button at the left turns snap on or off.  Next to it is an area that shows the 
current setting (which is set to Grid).  The size of the grid is set by the next two 
boxes - the first is currently set to Bar (which we want).  Ignore the 1/16 section 
for the time being – this only applies if the middle menu is set to Use Quantize, 
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which you will need later on.
Later on, as your sequencing develops, you will find times when you don’t want 
to use snap, or you want it set to different values.  But initially it’s best to stick 
with it set to a grid of bars, as this leaves the least room for problems!
Trimming a part to size
When creating a song, it’s often made up of smaller ‘building blocks’ – these 
could be a verse, chorus or other section of a song that you wish to repeat.  When 
you originally record them, they might end up being too long, for instance if you 
didn’t hit stop right on the end of a bar, you may well end up with a bar of silence.  
This can be easily trimmed away – just hover your mouse over the part in ques-
tion, and it will have small  ‘handles’ at the bottom corners – one for the start and 
one for the end.

Here we see the part, with a bar of si-
lence at the end.  At the bottom cor-
ners there are ‘handles’ which you can 
click and drag to size the part.

If the part has been selected, it will 
look like this - dark with the ‘handles’ 
being lighter.

In either case, you can click and drag 
the end one to the left...
... to produce a part of the correct 
length.  Note that if you do this to an 
area which has notes in it, they will 
not be played, but they are not lost – 
you can extend the part again using 
this technique and they will re-appear.

Make sure snap is turned on when doing this, or the timing of your part will suffer.
Adding another track
To add another track, you can do so in the way you did before – go to Project > 
Add Track > Instrument.  It is important to experiment with the different Instru-
ments you have on your system, which can create a wide range of sounds.
Adding Drums
Drums are an important part of many styles of music, so adding them is often 
needed.  To do this, create an instrument track as shown above, but this time 
you will pick Groove Agent SE from the Instrument menu.  Now, using the patch 
selector (as shown on page 5) pick the Dry Standard Kit (remember you can 
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search for it with the keyword ‘drum’). This means that instead of playing notes, 
the keyboard will play drum sounds – on most keyboards/synths you will find 
that the C note to the left of the keyboard will be a bass drum, with snare above 
it on D and E, toms above that, while the hi-hats will be on F#, G# and A#.  Learning 
what sounds are where will take some time (experiment to find which sounds are 
where), but the basic parts of the drum kit are found on the left-hand end of the 
keyboard.  There is a map of some of the keyboard in the MIDI Chapter on page 
62.  As before, recording drums is just like recording any other MIDI, although 
the playing may be more complex if you’re trying to play a full kit’s worth at once.
Adding more notes to a part
If you have problems playing all of a drum track at once, then there are a num-
ber of ways to do it.  The first way is to record ‘on top’ of the first part you have 
recorded.  Simply go back to the beginning of the track, and then record again on 
the same track – the notes you’ve already played will be played back to you, and 
you’ll create a new part on top of the original one; Cubase will show the part with 
diagonal lines on it to show you that there is more than one part in that location, 
and once you’re happy with the second part you have made, you can select the 
‘glue’ from the toolbar at the top and glue the top part to the bottom – you’ll now 
see a part with both sets of notes in (see diagrams below).  Once you’re finished 
working with the glue, you can return to the arrow tool, either by using the tool-
bar, or right-clicking on the white area of the project window and selecting it from 
the pop-up menu.

Here we see the initial part that has been record-
ed.  Cubase is set to record from the start on the 
same track, and we see below.....

... that the notes get recorded and seem to be in 
the same part, but the part has a diagonal pattern 
on it - this shows that there is another part below 
this one.  Both still play, even though they are on 
top of each other.  If we want them to be one part, 
we select the glue from the toolbar above, and 
click on the part, leading to...

.... a final part which has the notes of both parts.
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Picking which tracks play
Cubase has two important buttons which will let you hear the tracks you want, 
and stop others from playing.

Mute
Mute will stop any track that has it turned on from playing.  Click on the button so 
that it is selected in yellow, and play your track back - the track will not be heard.  
You can do this for as many tracks as you want.  To un-mute them, either click the 
mute button on the track, or you can clear all mutes with the clear mutes button 
which is in the toolbar at the top of the window.  

If you want to mute a track you have selected (i.e. it is in white in the list) then 
press M on the keyboard.

Solo
Solo will mute all tracks other than the one(s) you have soloed (press S).  This 
makes it quick and easy to hear a track you want to hear in isolation.  You can solo 
multiple tracks if you want, and each one is toggled by clicking the solo button 
on the track in question. CTRL clicking a Solo button will mute any other already 
soloed tracks.  As with mute, there is a clear all solo button in the toolbar at the 
top of the window.

Creating an arrangement
Usually, a song will consist of several parts, some of which will be repeated.  This 
can be done quickly and simply in Cubase.  Firstly, create the parts that you want 
to use for the song – you can do this on several tracks, using different instru-
ments, but for clarity the diagrams below will only show one track.
The first thing to realise is that you can move any part to a new location by click-
ing and dragging it there.  When you do so, make sure you have snap turned on, 
as then your part will be in time.  You can also drag a part to a new track to make 
it play on a different sound – sometimes this happens accidentally.  
However, often copies of the original parts are needed, to make the piece larger – 
repeating sections of an entire song, or copying a bar from one place to another.  
There are a few ways to do this, as seen below.

Here we see the original part, 4 bars from bar 1 to 
bar 5.   For each step below, the first part has to be 
selected.
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Edit > Functions > Duplicate.  A single copy is 
made, directly after the original part.

Edit > Functions > Repeat.  A new dialogue box 
appears, asking for the number of copies – here 3 was 
entered. Useful for creating many copies.	
Holding down ALT while dragging the part to a new 
location will create a copy – this is useful when a copy 
doesn’t need to be directly after the original.

Using these simple techniques allows a song’s structure to be built up quickly and 
easily.
Practicing a section
When a part is simple to play, then it can often be done with little practice.  But 
sometimes it’s necessary to repeat a section so you can practice or work out what 
you want to play.  Here’s where the locators come in.  Cubase has two main loca-
tors, left and right.  They can be used to create a cycle which Cubase will repeat 
until you tell it otherwise.  To do this, firstly we need to set the left and right loca-
tors.  This can be done in a number of ways:
1 – Double-click the area on the transport bar where the current value of the 
locator is, and enter a new value.  For bar 5, just hit 5 and Enter on the keyboard.
2 – You can CTRL-click on the ruler (showing the bars across the top of the pro-
ject window’s white area) to set the left locator, and ALT-click to set the right 
locator.  This needs accurate mouse placement, though.
3 – If you have a part or parts that you want to cycle round, select them and then 
hit P on the keyboard.
All of these will set the locators, and once you have done this, you can activate 
Cycle on the transport bar (the button to the left of stop – it will turn blue when 
it’s on), and Cubase will cycle round the contents between the two locators.  You 
can now practice the section that you wish to record or create until you get it 
right.
Cycle Recording
While cycling to play a section and practice it is useful, it is also useful sometimes 
to record while in cycle mode.  This gives a number of different options, including 
recording several different versions of the same part, or to add notes to the part 
as you go.  We will look at three of the available options.
Adding notes to a part
A common need is to add notes to a part.  While we have seen this being used 
when recording without Cycle mode, in cycle mode it is possible too.  The first 
thing is to ensure that the MIDI Record Mode is set to Mix, by clicking the button 
on the next page.
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Clicking here will summon the MIDI Record Modes menu:

Now, with the locators set, a part can be played.  Each time round the cycle, the 
notes you play will be added to the previous notes - they will not overwrite them.  
This is a quick way of building up a drum part, as seen here.  The first time round 
the cycle, the bass and snare drums were played:

The next time round the hi-hats were added:

You can cycle round as many times as you like, and whenever you add a note it 
will become part of the recording.
Keeping only the last version
If you want to keep only the last version you record, this is easily done.  Set the 
MIDI Record Mode to Keep Last:

Now proceed as in the previous section; when you stop, only the last version you 
did will be left.  This can be useful when you are trying to get a part right, and will 
stop as soon as you have done that.  Often if you keep starting and stopping to 
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record, it can stop you from getting in the feel of things, so having Cubase cycle 
round until you get it correct can save time. 
Recording different versions
Sometimes, you may want to keep recording while you play different versions of 
that section, and then decide later which version you want to keep.  To do this, set 
the MIDI Record Mode to Stacked, from the right-hand side of the pop-up menu 
on the Transport Bar.

As you record with cycle turned on, you will see each part recorded, and it may 
look as if the other versions have been lost (much as in the previous section) - 
here is the result after four cycles.  

Note that the part says Take 4 - this was on the fourth repeat.  If we play the track 
back, we get the fourth version that was played.  However, the others are still 
present.  Clicking the Show Lanes button will reveal the previous 3 Laps.

At present, Lap 4 is the version that is heard.  If you want to hear another one, 
you can use the Comp tool - see page 522 - or you can use the Mute tool to mute 
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one of the lanes, and then again to allow another one to play (see page 30 for 
the Mute tool).   The Comp tool is explained on page 522 in the Audio Editing 
chapter, but works for MIDI as well as audio, so the instructions there will show 
you how to use it for more than merely choosing which lane to play.  Note that 
with either method, if you change the lane which is active, the note display on the 
track changes to reflect the part that will be played - here Lap 2 has been chosen, 
and the track part reflects this both in name and note content.

If you want to return the track back to being viewed normally (without lanes), 
then click the Show Lanes button again.

Retrospective Record
There will be many times when you will play an idea that you think worked well, 
but you weren’t recording it - and sometimes it can be difficult to remember ex-
actly what you did.  In the past, this would have been gone forever, but Cubase 
has a feature called retrospective record which essentially means Cubase is al-
ways recording MIDI input.  This means all you need to do is press the retrospec-
tive record button and the events will be put onto the currently-selected track.
Here’s an example - while it is difficult to see something that hasn’t happened in a 
screen shot, you can try this yourself to get a chance to see how useful retrospec-
tive record can be.  
The setup is simple - a single instrument track in a project.  Play was pressed (but 
NOT record!) and a MIDI keyboard was played for a few bars of melody.  After hit-
ting stop, this was the result:

No MIDI data has been recorded to the track.  
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However, pressing the retrospective record button will make Cubase behave as if 
record had been pressed:

The MIDI data can now be edited as normal - it is now a normal MIDI part.  Ret-
rospective record has another trick up its sleeve - you don’t even need to have 
pressed Play - if you have just been playing MIDI while Cubase has been in Stop 
mode, it will still record.  Again, starting from a blank track, but not pressing play, 
MIDI notes were played on a keyboard.  Pressing retrospective record this time 
once more generated a recording:

Clearly the timing of this may be off (as there was no metronome to play along 
with), but it can still be invaluable to capture those inspirational moments that 
come along every now and then.
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Editing
One of the most powerful reasons to use a computer for creating music is that 
you can alter what you’ve played after the event – you can change the sound that 
something is played back on, and you can also alter the notes that you’ve played.  
Simple editing will save you hours of work – while it is always a good idea to try 
to improve your keyboard skills and play something in real time, there will always 
be times when you will need to edit what you have played.  To open the editor, 
double-click a part you have recorded.  This will open the ‘key editor’, which is like 
the paper roll from a player piano.

Here we see the key editor, with time running 
from left to right, and the notes going up the 
left-hand side of the screen, from low to high.  
The notes of the part are represented as rectan-
gles, and the colours show how hard the note 
was hit (called Velocity in MIDI terminology), 
from blue to red (soft to hard).

The first editing is quite simple.  As we’ve seen in the project window, each note 
can be moved to a new location, and again it is controlled using snap – this will 
make the notes ‘stick’ to a grid, and we can set the size of the grid. 

Listen to the part you’ve created, and work out the grid that it should fit to – if it 
has only one note per beat (quarter notes/crotchets), then set the snap to ¼.  If it 
has two even notes per beat (eighth notes/quavers) then set it to 1/8, etc.  Once 
you have done this, you can move the notes to the ‘correct’ location by clicking 
and dragging them – note that the position that you click on the note is crucial – if 
you click at the beginning or end you drag the note out.  If they are all fairly close 
and you have set the snap setting correctly, then hit Q on the computer keyboard 
for ‘quantize’ – this will move each note to the nearest ‘correct’ grid position; this 
may or may not work well depending firstly on if you’ve chosen the correct snap 
setting, and secondly if you’ve played it accurately!  It’s not unusual to have to 
correct some notes by hand, but quantizing can save a lot of manual work.  There 
is more information on this on page 84.
If there are any notes that you don’t want, you have two choices - either double-
click a single note, or select one or more and hit Delete.   
You can also edit the velocity of the notes that you have played (i.e. how hard you 
played them – for most synths this translates into the volume of the notes being 
played). This is done in the “controller lane” at the bottom of the window, as seen 
on the next page:
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If there is no controller lane, click on the plus at the bottom of the editor area and 
one will appear.  

If the controller lane is not displaying velocity, click on the triangle that appears 
on the current controller name to bring up the pop-up menu, and pick Velocity 
from it.

You can pick a variety of parameters to edit with the pop-up menu on the left of 
the lane, but Velocity is what we’re after at the moment. You should see coloured 
bars which represent the velocities of each note that you have played – by de-
fault, they will be short and blue for lightly-played notes, tall and red for notes 
that were played loudly, and in-between for others.  You can see that in this ex-
ample, they are all the same velocity (100 in this case, from a range of 1-127).

To edit the velocities, you can move the selection tool over the velocity area - note 
that it turns into a pencil when you move there.  You can now click and drag the 
note velocities to the desired levels, and you should hear the effect of doing so.
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You can also use the line tool in a variety of modes (see page 31), which will 
allow you to alter the velocities in a number of different ways.

Once you’re finished in the editor, hit Enter and you’ll be back to the project 
window.
Non-Keyboard player tips
If you are not already a competent keyboard player then you may find sequencing 
quite frustrating or difficult – particularly if you are trying to sequence something 
that already exists.  There are a number of things you can do to help your situa-
tion:
Keyboard Skills – improving these will pay the largest dividends.  If you can learn 
basic keyboard technique it will enable you to translate your ideas into parts a lot 
more quickly.  Knowing where the notes are on the keyboard is important, as is 
being able to play simple chords.  If you can gain some independence between 
your two hands then this will make matters even better, particularly when you 
start to program drum parts in real time.
Slowing things down
Often a complex part will be difficult to play at the correct speed, and one way 
round this is to slow Cubase down, and then play the part at a lower (achievable) 
speed – see page 5 – and you can then put Cubase back to the original speed.
Recording rhythm then changing the pitch
This is a useful skill when you know what you want to play but can’t do it quickly 
enough (or it’s too complex to get).  Firstly, pick a note that fits OK with whatever 
backing you have, and then record the correct rhythm of the piece, but all played 
at the same pitch – this should be doable for just about everyone.  
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Here we see the rhythm of our melody has been recorded, all on a single note.

The next step is to correct the pitches of the notes that you’ve played in.  You can 
do this by editing each one, but it can be laborious.  If you know what notes you 
need to play (which is often the case with a melody which you know or that’s 
written down) then open the part you have just recorded in the key editor.  Select 
the first note of the melody, and then click the MIDI Input button at the top.   This 
enables input from the MIDI keyboard.  You will see there are three buttons with 
notes on to the right of this.  Make sure the ones with the arrows are turned off - 
this will mean only the pitch of the note is being altered as you press keys on your 
keyboard.  The correct setting is shown below.

You can now play the correct pitches in, one at a time, and Cubase will alter the 
pitch of the current note, and move to the next one.  In this way anyone who can’t 
read music quickly can input a rhythmically accurate version and then change the 
pitches quickly - below is the part with half the notes replaced.

Below is the completed melody.  Don’t forget to turn MIDI Input off after com-
pleting the task, as otherwise you may accidentally alter a part without realising. 
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Step Input
There is another way to record MIDI data in Cubase, and instead of being in real-
time (like the recordings we have already seen), it is done in what is called ‘step 
time’.  This means that there is no clock or timing running, instead Cubase will 
move forward in time each time you play a note, and you can wait as long as you 
like between them.  This removes the need to play notes in quick succession, 
which can often be useful for those first using the keyboard, or when sequencing 
parts which are too difficult to play at a reasonable speed.  It also opens up some 
more creative possibilities as well.
To use Step Input, firstly create a new, empty part.  This can be done in a number 
of ways, either selecting the pencil tool in the project window and clicking and 
dragging to draw the part:

Or if you have your locators set you can double-click between them on the ap-
propriate track.  

Once you have your part, double-click it to open it in the editor.  You will now 
need to turn Step Input on, using the icon located towards the top of the editor. 
(you may need to enable Step/MIDI input by clicking the cog in the top right of 
the editor window)

Next, set the step size.  This is done by altering the quantize value at the top of 
the editor, seen here set to 1/8.

You may have noticed that as soon as you turned Step Input on, a blue indicator 
appeared at the play position on screen, as seen below:

This is where Step Input will be active.  If you want to alter where the notes ap-
pear, use the left and right cursor keys on your keyboard to move to the correct 
location.  You can also set it by clicking in the main section of the editor window 
(where the notes appear).
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Here is the empty part, with the step input line on 
the left . You should see the blue triangle and line 
showing where the input will occur.  Cubase is ready 
to take the next note or chord played, and when 
you do so and release it...

...two things happen:  Firstly, the note or chord that 
you played has been created in perfect time - it 
starts precisely where the input location was set, 
and it is exactly the length you set.  Secondly, the 
blue step input line will have moved on to the next 
grid division, ready...

... for the next one.  Once it is played and released, 
the same thing happens again - the ‘perfect’ chord/
note is created with the right start and end points, 
and the step input line moves another division for-
ward.  

It is possible to alter the duration of the notes cre-
ated using the cursor left and right keys.  Here the 
right cursor key was pressed twice before releasing 
the notes, leading to a chord of double the usual 
duration.

Note that when you are using Step Input, once you press a key on the MIDI key-
board, you can press more keys to make a chord, and it is only when you release 
them all that the input is actually taken, so you don’t have to hit all the notes at 
the same time.  As with MIDI note input above, ensure you turn Step Input off 
when you have finished, or you can enter notes without realising it!
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Pitch Bend
So far, the notes we have seen have all been discrete, and at least a semitone 
apart, like the notes on a piano keyboard.  Many instruments as well as the voice 
are capable of playing notes which don’t fit into this ‘grid’ of pitches.  MIDI has 
the facility to achieve this by using what is called Pitch Bend - which allows the 
alteration of the pitch of a note to another pitch - whether in-between the ‘grid’ 
of pitches, or sliding from one to another.  Pitch Bend has the ability to bend a 
note up or down in pitch from the original, so the display in Cubase starts with 
zero in the middle.
Pitch Bend can be created by using the controller lane as already seen (strictly 
speaking, it’s not a controller, but we’ll leave that discussion for another time).  
By selecting Pitchbend instead of Velocity in the controller lane, it’s possible 
to enter any pitch bend which is already present, or to create pitch bend data as 
we’ll see next.
Here is a single note, which lasts for four bars.  When played, it is just the pitch of 
C3, and it doesn’t change.  A synthesizer sound has been chosen for this as it will 
sustain (sound) for the entire length of the note, which is needed - if the sound 
stops before the pitch bend happens, its effect will be unheard.

With the controller lane set to Pitchbend, it is possible to draw in a single point 
which will alter the pitch at that time - instantly changing pitch, but without play-
ing a new note.

By default, most synthesizers have an up and down pitch bend range of 2 semi-
tones.  Here the Pitch Bend is under half of the range available from the default 
(the centre), so it will be a bit below a C# note.  The default display of pitch bend 
uses Cubase’s values with a maximum of +100 and a minimum of -100, with 0 in 
the middle as no pitch bend.  This is not how MIDI actually sends the values, so 
for more information on how MIDI works for pitch bend, see page 56 if you 
want to go deeper.  Here the point has been moved up the maximum (note the 
100 readout):
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To use a more musical range of semitones for pitch bend, click the cog in the con-
troller lane ...

... and in the window that appears, select Show Semitones Grid.

Notice that two things have happened - firstly, there is now a scale of +2 to -2 
semitones at the left, and secondly, moving any point tells you the pitch in semi-
tones, rather than raw MIDI data (note the 2.00 readout):

Clicking on the line and dragging to a new location will draw another point, allow-
ing the pitch to alter again when played back:

Turning on snap with the button to the left of the cog allows easy creation of ac-
curate pitch bend data. 
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Altering Pitch Bend Curves
Once you have more than one pitch bend event, hovering the mouse between 
them will show a circle:

Clicking and dragging this circle will allow the creation of smooth curves between 
the points, as seen in the examples below (note that the two pitch bend points 
have not moved, but the transition between them has been edited by dragging 
the circle).

In this way it is possible to build up smooth transitions between pitches with a 
minimum of effort as Cubase will create the data needed to make the change 
smooth, and altering the start or end points can be done quickly, while retaining 
the smoothness of the transition.

Editing MIDI Controller Data
MIDI controller data can be created and edited in the same way as already seen 
for pitch bend, although the range of data is typically 0-127 instead of -8192 to 
+8191.  Use the same method of creating points first, and then altering the line 
between them to achieve the desired transition.  This will allow accurate and 
smooth edits and transitions to be created.

Once you are more familiar with the basics and move on to the techniques shown 
in the Effective Sequencing chapter on page 71, you will find these skills invalu-
able.
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Saving your work
This is the most important thing you can do!  Make sure that you save your work 
regularly.  It is an unfortunate fact of life that computers crash sometimes.  Cu-
base is a very complex piece of software – we’ve just scratched the surface of it 
here – and sometimes it crashes.  Whenever you’ve done something that you like, 
save your work! It’s quickly done by pressing CTRL+S, and it can save you hours of 
time if something goes wrong.  You can also set Cubase to auto-save by going to 
Edit > Preferences > General and ticking  Auto Save – it’s really easy to forget 
to save work in the middle of a sequencing session, so this is a good idea.  If you 
need to back your work up, then see page 51 for how to do this.

The Toolbar
At the top of the project window and editors in Cubase you will see the toolbar.

This allows you to select different tools, making the mouse cursor perform differ-
ent tasks.  We will now look at the tools that are available to you, and some of 
their uses. 

The Selection Tool (Press 1)
This is the default mode - the arrow that you have already been using - where you 
can click and drag a part to a new location, and use the sizing handles that appear 
to alter the length of parts.  This is the mode you will use more than any other, 
and it can be accessed by pressing 1 on the main keyboard.  If you click and hold 
on the tool on the toolbar, a pop-up menu appears:

This allows the selection of different modes for the tool, which alter what hap-
pens when you re-size an event.  Note that pressing 1 repeatedly will cycle through 
these modes.
Normal Sizing
As we have already seen, it is possible to click and drag a start or end handle, and 
change the length of a part.  This is the default mode.
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Sizing moves contents
In this mode when you re-size a part, the contents will move when you do so.  
Here is an example to show that in action.

Sizing applies Time Stretch
In this mode, when you re-size a part, the contents will be stretched or squeezed 
according to the change in length that you apply.  Here is an example to show that 
in action.

The Range Selection Tool (Press 2)
The Range Selection Tool lets you click and drag to select an area across a number 
of tracks, and then move the contents of the area you have outlined to a new 
location by clicking and dragging.  It can be useful for making large changes to a 
sequence without having to spend a long time separating all the parts that you 
want by using the scissors (see the next section for the scissor tool).  Here we see 
a sequence which has had an area selected by clicking and dragging.
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Once the area has been selected, hover the mouse over it - it will turn into a hand 
and now the area can be moved by clicking and dragging.



28

Sequencing - Sample Chapter

Sa
mple

 do
wnlo

ad
ed

 fr
om

www.m
us

ict
ec

ht
uiti

on
.co

m

Combine Selection Tools (Press ALT + SHIFT + 1)
It is possible to use both the selection and range selection tool by clicking the 
button to the left of the selection tool.  In this mode, range selection works in the 
top half of a track, and selection in the bottom half.  It can save on mouse mile-
age, and make for a faster, more productive workflow once you have mastered 
its intricacies. 
However, it can be frustrating to use at first as you need to be accurate when 
working in the project window , and it may well be something that is best left 
turned off while you master the use of each tool individually.

The Scissors (Press 3)
The scissors allow you to cut existing parts into smaller ones.  Here we will see the 
scissors in action - here is an existing part:

Clicking with the scissors at bar 2 creates 2 parts from the original.

Note that the long note from the end of bar 1 (which extended over the bar 2 line 
where the cut was made) does not appear in the second part - the notes them-
selves are not cut.  Looking inside the first part shows us that the note is intact, 
and extends beyond the new part.  

This can lead to some confusion when cutting parts with MIDI notes in, so be 
aware that things like this can happen.
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The Glue (Press 4)
The Glue tool allows parts to be glued together and become one part.  Taking the 
parts created by cutting above, we can see that the reverse of the cutting process 
happens:

Clicking on the first part glues it to the following one, as seen on the next page:

Note that the long note from the first part now has its true length shown. Glue 
can bridge the gaps between parts, as seen here:

Later on, when working with audio, note that glue will only glue audio events to-
gether that originally belonged together; if they didn’t then an audio part will be 
created, which is a container with multiple audio events in it.

The Eraser (Press 5)
The eraser allows you to delete parts by clicking on them.  It is often quicker to 
stay on the Selection tool, click on a part and hit Backspace on the keyboard, but 
you may prefer using the erase tool.

The Zoom Tool (Press 6)
As its name suggests, the zoom tool controls zooming in and out.  It has two main 
ways of working.  If you click on a track without dragging, it will zoom in.  ALT+click 
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will zoom out.  However, if you want to zoom into a particular area, you can click 
and drag that area using the zoom tool, and once you release the mouse button, 
that area will fill the screen.

The Mute Tool (Press 7)
The Mute Tool can be extremely useful - it allows the muting of a part, stopping 
it playing without moving or deleting it.  This can be extremely useful for creating 
arrangements and testing ideas out.  Here we see an original track, with three 
parts:

The middle part will now be muted using the mute tool - note that it has gone 
grey (easier seen on screen than in print!), and it will not be played.  

Clicking again will allow the part to play normally.

The Pencil Tool (Press 8)
The Pencil (or Draw) tool allows the creation of parts and events - this has already 
been seen on the section on Step Input on page 19.  Clicking and dragging with 
it will create new parts or events, controlled by your current snap settings.

The Play Tool (Press 9)
The Play Tool allows you to play a part by clicking and holding on it.  Note that 
only the part you click on will be played - if there are other tracks which happen 
at the same time they will not be played.  This is similar to using Solo, as covered 
on page 10.
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The Line Tool
The Line tool has a number of modes, as seen below.

Line - creates straight lines

Parabola - creates curves.  Pressing CTRL flips the curve

Sine, Triangle and Square - create repeating waveforms, with the wave-
length (i.e. how often the cycle repeats) is set by the Snap value.  This can 
be extremely useful for creating repetitive data.  CTRL, SHIFT and ALT act 
as modifiers to change the creation mode.

The Line tool allows the creation of notes in the editor, the editing of velocities 
and controller data in the controller lane (as seen on page 16), as well as auto-
mation data (see page 341).  In the line and parabola mode it can be very useful 
for making smooth edits of velocity and controller data (as seen in the Effective 
Sequencing chapter on page 71).  If you are feeling avant-garde, it can also be 
useful for creating unusual patterns of notes in the key editor.
In the key editor, another mode - Paint - exists, allowing free creation of note 
data.

The Time Warp Tool
The Time Warp Tool allows you to alter Cubase’s tempo by dragging bars to a de-
sired location, producing complicated and accurate tempo changes quickly and 
visually.  This is covered in the Audio Editing chapter, starting on page 489.
In addition, it has a third mode where it can be used to apply AudioWarp to audio 
events directly in the project window.  This is covered on page 506.

The Comp Tool
The Comp Tool allows you to piece together a best performance from a number 
of tracks you have recorded.  This is covered on page 522.
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Editing Drums
While it is possible to edit drum parts that have been played using the key edi-
tor, it is often better to do this editing in the drum editor – this is for two main 
reasons.  Firstly, the length of a drum note is irrelevant – the sound will play for 
the same duration regardless of how long you hold the key down.  Secondly, with 
a drum part it is often important to be able to edit the velocity and quantization 
of each drum instrument individually, and this is not easily achieved in the Key 
editor.  To open the drum editor, select a drum part and pick MIDI > Open Drum 
Editor.  You will see a window like the one below.

There are many similarities to the Key editor, but the main differences are listed 
below.
Each note (a drum sound) is represented by a single line, and named for conveni-
ence.  It is possible to alter the order of the notes by clicking and dragging them 
by their names) to their new position.
The controller lane will only show the velocity of the currently-selected notes – 
notice in the above diagram only the bass drum velocities are shown.
Quantize can be applied globally or set individually; with Use Snap from Drum 
Map selected (as seen with the -|+ button below) then each drum instrument can 
be quantized to the appropriate value quickly and easily. It’s also possible to pick 
Use Quantize from here, and set a single value across all drum instruments.

By default, note duration is not shown – each note is simply shown as a diamond, 
but the button below right can show note lengths if this is required.    

The length of any notes created with the drumstick (the pencil tool, essentially) 
can be set with this menu - linked to the drum map or explicitly set.

Volume and Panning
The last thing we’ll cover here is setting volumes of parts – this is important as 
the balance between instruments is totally under your control – you can do this 
by setting the volume using the slider in the inspector, as seen on the next page.
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The volume fader – from off (left) to loud (right) – click 
and drag the slider at the bottom to set it.
The pan control – this allows the sound source to be 
placed from left, through centre, to right; again click and 
drag the slider to set the position.

Both these controls work per track - it’s important to remember that the Inspec-
tor works on tracks, not on parts.

Incorrect - a part on the Melody track is selected, but 
the inspector shows the settings for the track which is 
selected, in this case the Drums.  Changing settings will 
alter the Drum track, not the Melody one.

Correct - the Melody track has been selected, so the in-
spector is now showing the settings for that track.

Getting the balance right between instruments can make a big difference to your 
composition and how it is perceived by the listener, so take some time to get this 
right.  Also note that if they are set to “off” then it means that no value has been 
sent yet; it’s never a good idea to leave them like this as you may inherit odd set-
tings from a previous sequence.

The MixConsole
You can also set the volume and panning using Cubase’s mixer, known as the Mix-
Console.  It can be summoned using the F3 key or via Studio > MixConsole.  You 
should see a window similar to the one shown below.  

At the bottom right are the mixer channels.  
These have faders which allow you to control the 
level of each channel.  The channels are colour 
coded - by default, red for input or output chan-
nels, and cream for instrument channels.  Moving 
the fader up or down will alter the volume of that 
track. The input seen on the left-most channel is 
the audio input - we will not be using this yet, but 
you may see a signal there (as seen in the screen-
shot) - don’t worry about it for the moment. The 
right-most channel is the Stereo Out, and it con-
trols the overall volume of your project.

It is the same control as seen on the section on the Transport Bar earlier in this 
chapter. On the left, there is a section covering Visibility, History and Snap-
shots.  This will be covered in the mixer chapter, but you can make a channel 
disappear from the mixer by clicking the tick to the left of its name.  The section 



34

Sequencing - Sample Chapter

Sa
mple

 do
wnlo

ad
ed

 fr
om

www.m
us

ict
ec

ht
uiti

on
.co

m

at the top right is where more in-depth manipulation of each channel can be 
performed, adding in a variety of effects and processing.  We will not be using 
this section yet, but it will be covered later on in the mixer chapter and others.  
Remember - the mixer’s appearance will change as you add more tracks, but the 
basics will remain the same.  The MixConsole is covered in detail in its own chap-
ter on page 587.

This sample represents around half of the first chapter of the 
book, and 33 of the 700 pages of content in the book.

If you find it useful, please support its creation by buying this 
book from Amazon.com

https://tinyurl.com/cubase13book

The Complete Guide To Music Technology Using Cubase 13

ISBN 9798850592387

www.musictechtuition.com


